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Preface

The Sun™ Enterprise™ 10000 SSP 3.1.1 User’s Guide describes the System Service

Processor (SSP), which enables you to monitor and control the Sun Enterprise 10000

system.

Before You Read This Book

This manual is intended for the Sun Enterprise 10000 system administrator, who

should have a working knowledge of UNIX® systems, particularly those based on

the Solaris™ operating environment. If you do not have such knowledge, you

should first read the Solaris User and System Administrator AnswerBook™

provided with this system, and consider UNIX system administration training.

How This Book Is Organized

This document contains the following chapters:

Chapter 1 introduces the System Service Processor (SSP).

Chapter 2 introduces the Hostview Graphical User Interface (GUI) and the

netcontool(1M) command.

Chapter 3 describes how to perform common system administration procedures.

Chapter 4 provides more detailed information for system administrators interested

in how the SSP works. Included are descriptions of the SSP booting process and the

edd(1M) daemon, which monitors the Sun Enterprise 10000 system.
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Using UNIX Commands

This document does not contain information on basic UNIX commands and

procedures such as shutting down the system, booting the system, and configuring

devices.

See one or more of the following for this information:

■ AnswerBook online documentation for the Solaris software environment,

particularly those dealing with Solaris system administration.

■ Other software documentation that you received with your system
x Sun Enterprise 10000 SSP 3.1.1 User Guide • August 1999



Typographic Conventions

Shell Prompts

TABLE P-1 Typographic Conventions

Typeface or
Symbol Meaning Examples

AaBbCc123 The names of commands, files,

and directories; on-screen

computer output.

Edit your .login file.

Use ls -a to list all files.

% You have mail .

AaBbCc123 What you type, when

contrasted with on-screen

computer output.

% su
Password:

AaBbCc123 Book titles, new words or terms,

words to be emphasized.

Command-line variable; replace

with a real name or value.

Read Chapter 6 in the User’s Guide.

These are called class options.

You must be root to do this.

To delete a file, type rm filename.

TABLE P-2 Shell Prompts

Shell Prompt

C shell machine_name%

C shell superuser machine_name#

Bourne shell and Korn shell $

Bourne shell and Korn shell superuser #
xi



Related Documentation

Accessing Sun Documentation Online

The docs.sun.com SM web site enables you to access Sun technical documentation

on the Web. You can browse the docs.sun.com archive or search for a specific book

title or subject at:

http://docs.sun.com

Sun Welcomes Your Comments

We are interested in improving our documentation and welcome your comments

and suggestions. You can email your comments to us at:

docfeedback@sun.com

Please include the part number (805-7519-10) of your document in the subject line of

your email.

TABLE P-3 Related Documentation

Application Title

Installation Sun Enterprise 10000 SSP 3.1.1 Installation and Release Notes

Reference (man pages) Sun Enterprise 10000 SSP 3.1.1 Reference Manual

Release Notes Sun Enterprise 10000 SSP 3.1.1 Installation and Release Notes

Other Sun Enterprise 10000 Dynamic Reconfiguration User’s Guide
Sun Enterprise 10000 Dynamic Reconfiguration Reference Manual
Sun Enterprise Server Alternate Pathing User’s Guide
Sun Enterprise Server Alternate Pathing Reference Manual
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CHAPTER 1

Introduction to the SSP

The System Service Processor (SSP) is a SPARC™ workstation that enables you to

control and monitor the Sun Enterprise 10000 system. The SSP software packages

must be installed on the SSP workstation. In addition, the SSP workstation must be

able to communicate with the Sun Enterprise 10000 system over an Ethernet

connection. In this book, the SSP workstation is simply called the SSP.

Sun Enterprise 10000 system is often referred to as the platform. System boards

within the platform may be logically grouped together into separately bootable

systems called Dynamic System Domains, or simply domains. Up to eight domains

may exist simultaneously on a single platform. (Domains are introduced in this

chapter, and are described in more detail in “Domains” on page 56.) The SSP enables

you to control and monitor domains, as well as the platform itself.

Note – You should not run any software on the SSP machine other than the SSP

software. (If you are using clusters, you can run the Sun cluster console on the SSP.

Clustering is beyond the scope of this manual.)

SSP Features

SSP 3.1.1 software can be loaded only on Sun workstations running the Solaris 2.5.1,

Solaris 2.6, or Solaris 7 operating environment with OpenWindowsTM or the

Common Desktop Environment (CDE). SSP 3.1.1 software is compatible with Sun

Enterprise 10000 system domains running the Solaris 2.5.1, Solaris 2.6, or Solaris 7

operating environments. The commands and GUI programs that are provided with

the SSP 3.1.1 software can be used remotely.

The SSP enables the system administrator to perform the following tasks:

■ Boot domains.
13



■ Perform an emergency shutdown in an orderly fashion. For example, the SSP

software automatically shuts down a domain if the temperature of a processor

within that domain rises above a pre-set level.

■ Dynamically reconfigure a domain so that currently installed system boards can

be logically attached to or detached from the operating system while the domain

continues running in multiuser mode. This feature is known as dynamic
reconfiguration and is described in the Sun Enterprise 10000 Dynamic Reconfiguration
User’s Guide. (A system board can easily be physically swapped in and out when it

is not attached to a domain, even while the system continues running in

multiuser mode.)

■ Create domains by logically grouping system boards together. Domains are able

to run their own operating system and handle their own workload. See

“Domains” on page 56.

■ Assign paths to different controllers for I/O devices, which enables the system to

continue running in the event of certain types of failures. This feature is known as

alternate pathing (AP) and is described in the Sun Enterprise Server Alternate Pathing
User’s Guide.

■ Monitor and display the temperatures, currents, and voltage levels of one or more

system boards or domains.

■ Control fan operations.

■ Monitor and control power to the components within a platform.

■ Execute diagnostic programs such as power-on self-test (POST).

In addition, the SSP environment:

■ Warns you of impending problems, such as high temperatures or malfunctioning

power supplies.

■ Notifies you when a software error or failure has occurred.

■ Automatically reboots a domain after a system software failure (such as a panic).

■ Keeps logs of interactions between the SSP environment and the domains.

System Architecture

The Sun Enterprise 10000 system platform, the SSP, and other workstations

communicate over Ethernet (FIGURE 1-1).
14 Sun Enterprise 10000 SSP 3.1.1 User Guide • August 1999



FIGURE 1-1 Sun Enterprise 10000 system and Control Boards

Dual control boards are supported within the Sun Enterprise 10000 system platform.

Each control board runs a control board executive (CBE) that communicates with the

SSP over a private network. One control board is designated as the primary control

board, and the other is designated as the alternate control board. Only one control

board is active at a time. If the primary control board fails, you can manually switch

to the alternate control board as described in “Dual Control Board Handling” on

page 74.

SSP operations can be performed by entering commands on the SSP console or by

remotely logging in to the SSP from another workstation on the local area network.

Whether you log in to the SSP remotely or locally, you must log in as user ssp and

provide the appropriate password if you want to perform SSP operations (such as

monitoring and controlling the platform).

SSP User Environment

You can interact with the SSP and the domains on the Sun Enterprise 10000 system

by using SSP commands and the SSP GUI programs.

Workstation

SSP

CBE

CBE

Control
Board 0

Control
Board 1

Sun Enterprise 10000

Control Board
Subnet 1

Control
Board
Subnet 2

LAN
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▼ To Begin Using the SSP

1. Boot the SSP.

2. Log in to the SSP as user ssp .

If you don’t know the password for user ssp , ask your system administrator.

3. Type:

4. Wait until you see the following message:

At this point you can begin using SSP programs such as Hostview and

netcontool (1M).

SSP Window

An SSP window provides a command line interface to the Solaris operating

environment and SSP environment (FIGURE 1-2).

FIGURE 1-2 SSP Window

ssp% tail -f $SSPLOGGER/messages

Startup of SSP programs complete

SSP or Other Workstation Display

SSP% rlogin ssp \
-l ssp

SSP window
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▼ To Display an SSP Window Locally in

OpenWindows

1. Log on to the SSP as user ssp .

2. When prompted for the value of SUNW_HOSTNAME, type in the name of the
platform or the name of domain that you want to work with, and then press
Return.

The SUNW_HOSTNAMEenvironment variable is set to that domain. OpenWindows is

started, and a cmdtool window is displayed along with a cmdtool console

window.

If you do not know the name of the domain or platform, ask your system

administrator.

▼ To Display an SSP Window Locally in the

Common Desktop Environment (CDE)

1. Log in to the SSP as user ssp .

2. Open an SSP window using one of the following methods:

■ From the CDE front panel under the Solaris 2.5.1 or 2.6 operating environment,

select the Personal Applications subpanel (which looks like a notepad), and then

select Terminal.

■ From the CDE front panel under the Solaris 7 operating environment, select the

Hosts subpanel, and then select This Host.

■ From the Workspace Menu (right mouse click) choose Programs and then select

Terminal.

This method works under the Solaris 2.5.1, 2.6, or 7 operating environment.

▼ To Display an SSP Window Remotely

1. Use the rlogin (1) command to remotely log in to the SSP machine as user ssp ,
and enter the ssp password.

2. When prompted, type in the name of the platform or domain you wish to work
with, and then press Return.

The SUNW_HOSTNAMEenvironment variable is set to the value you enter.
Chapter 1 Introduction to the SSP 17



SSP Console Window

The SSP console window is the console for the SSP workstation. The system uses it

to log operating system messages.

▼ To Display an SSP Console Window With

OpenWindows

Note – An SSP Console Window is created automatically when OpenWindows

starts. Thus, you do not need to use this procedure unless you accidentally exit from

the console window.

● On the SSP machine, type:

▼ To Display an SSP Console Window Locally

With CDE

1. Log in to the SSP as user ssp .

2. Open an SSP window using one of the following methods:

■ From the Workspace Menu (right mouse click) choose Programs and then select

Console.

This method works under the Solaris 2.5.1, 2.6, or 7 operating environment.

■ From the CDE front panel under the Solaris 7 operating environment, select the

Hosts sub-panel, and then select Console.

This method works only under the Solaris 7 operating environment.

Network Console Window

The network console window, or netcon (1M) window, receives system console

messages (operating system messages) from a domain. (FIGURE 1-3).

ssp% cmdtool -C
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FIGURE 1-3 netcon(1M) Window

A netcon (1M) window behaves as if a workstation was physically connected to a

domain. A netcon (1M) window can be used to boot and halt the operating system.

It also logs messages for operations such as dynamic reconfiguration of system

boards. For more information, see “netcon and netcontool Windows” on page 32 and

the netcon (1M) man page.

Hostview

The Hostview program provides a graphical user interface (GUI) with the same

functionality as many of the SSP commands (FIGURE 1-4).

Logical connection

Logical connection

Network

Sun Enterprise 10000

Domain 1

Domain 2

SSP
% domain_switch domain1_name

netcon(1M) windows

% netcon

% domain_switch domain2_name
% netcon
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FIGURE 1-4 Hostview GUI Program

Hostview is introduced in Chapter 2 and is described in more detail in Chapter 3. It

is also described in hostview (1M) in the Sun Enterprise 10000 SSP Reference Manual
(man pages).

SSP window

% hostview&

Hostview

SSP Network

Logical connection

Logical connection

Sun Enterprise 10000

Domain 1

Domain 2
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CHAPTER 2

Overview of the SSP Tools

This chapter introduces the Hostview GUI as the front-end to SSP commands and

the netcontool (1M) GUI as the front-end to the netcon (1M) command.

netcontool (1M) simplifies the process of configuring and bringing up

netcon (1M) windows. You can also use the netcon (1M) command directly to

display a netcon (1M) window. However, when using netcon (1M), you must know

escape sequences to perform operations that can be performed by clicking on

buttons under netcontool (1M).

The Hostview screen shots in this chapter were taken under OpenWindows. The

netcontool (1M) screen shots were taken under the Common Desktop

Environment (CDE). The window frames and buttons (such as the minimize button

and maximize button) appear differently in these two window systems.

Hostview

Hostview enables you to perform administration operations such as:

■ Dynamically group system boards into domains. Each domain runs its own

instance of the Solaris operating environment and has its own log messages file.

■ Boot the Solaris operating environment for a domain.

■ Access the SSP log messages file for each platform or domain.

■ Remotely log in to each domain.

■ Display a netcon (1M) window for each domain.

■ Edit the blacklist (4) file to enable or disable hardware components in a

domain.

■ Dynamically reconfigure the boards within a platform, logically attaching or

detaching them from the operating system. This feature is described in the Sun
Enterprise 10000 Dynamic Reconfiguration User’s Guide.

■ Power system boards on and off.

■ Monitor the temperature and voltage levels of hardware components.
21



If you want to run Hostview, you only need to run one instance for a given platform.

However, it is possible to run more than one instance simultaneously (perhaps on

different workstations) to work with the same platform.

If you have logged into the SSP environment from a remote login session, make sure

your DISPLAY environment variable is set to your current display and that your

xhost settings enable the SSP to display on your workstation (see xhost (1) in the

Solaris X Window System Reference Manual).

▼ To Start Up Hostview From a Remote Login

Session

1. Enable external hosts to display on your local workstation:

2. Log in to the SSP as user ssp and type the hostview (1M) command:

▼ To Start Up Hostview From the Workspace

Menu Locally on the SSP

● From the Workspace Menu (right mouse button click), select SSP, and then select
Hostview.

This is available only when you use the SSP workstation, not when you use a remote

login (rlogin ) session to the SSP.

▼ To Start Up Hostview Under CDE From the

Front Panel

● Use one of the following methods:

■ Click the SSP icon on the front panel.

This icon shows a hand holding tools.

■ Click the arrow above the SSP icon on the front panel, and select Hostview

% xhost +

ssp% setenv DISPLAY machine_name:0.0
ssp% hostview &
22 Sun Enterprise 10000 SSP 3.1.1 User Guide • August 1999



Log in as user ssp and type:

Hostview Main Window

When you start Hostview, the main window is displayed (FIGURE 2-1).

FIGURE 2-1 Hostview Main Window

ssp% hostview &

Control
Board

Support
Board

Power

Temperature Fans

Failure

System
Board

Buses

Selected
Board
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The menu bar on the main window provides the commands that you use to control

the platform. The commands are described in “Main Window Menu Bar” on page 26.

The buttons on the main window (Power, Temperature, and Fans) bring up status

details. The buttons are described in “Main Window Buttons” on page 28.

The rest of the main window provides a graphical view of the platform boards and

buses. The system boards are named SB0 through SB15, and their processor numbers

are shown. The control boards are named CB0 and CB1. The support boards are

named CSB0 and CSB1. The buses are named ABUS0 through ABUS3, DBUS0, and

DBUS1.

The system boards along the top of the display are arranged in the order they appear

on the front side of the physical platform. The system boards along the bottom of the

display are arranged in the order they appear on the back side of the physical

platform.

If a system board is shown with no outline (FIGURE 2-2), the board is not part of a

domain and is not currently selected.

FIGURE 2-2 Unselected System Board (domain independent)

If a system board is part of a domain (FIGURE 2-3), a colored outline surrounds it. The

boards within a given domain all have an outline of the same color.

FIGURE 2-3 Unselected System Board (domain dependent)
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A black outline around the domain color outline indicates that a board is selected

(FIGURE 2-4). (There are several reasons why you select a board in Hostview. For

example, you could select one or more boards, and then create a domain that is

based on those boards.)

FIGURE 2-4 Selected System Board (domain dependent)

The processors within the boards are numbered 0 through 63. The processor symbols

(diamond, circle, and so forth) indicate the state of the processors and are described

in “Main Window Processor Symbols” on page 30.

Selecting Items in the Main Window

You can select one or more boards in the Hostview main window. You can also select

one domain in the main window. You must select a set of boards prior to performing

certain operations, such as creating a domain.

■ To select a single board, click on it with the left mouse button. The selected board

is indicated by a black outline, and all other boards are deselected.

■ To select additional boards, click on them with the middle mouse button. You can

also deselect a currently selected board by clicking on it with the middle mouse

button. (The middle mouse button toggles the selection status of the board

without affecting the selection status of any other board.)

■ To select a domain, click on a board within that domain with the left mouse

button. Note that you can select boards from different domains (using the middle

mouse button), but the selected domain will correspond to the board that you

selected with the left mouse button.
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Main Window Menu Bar

The items on the main Hostview menu are described in TABLE 2-1.

TABLE 2-1 Hostview Menu Items

Menu Submenu Items Description

File SSP Logs Displays a window that shows the SSP

messages for a domain or for the platform.

For more information, see “SSP Log Files”

on page 43.

Quit Terminates Hostview.

Edit Blacklist File Enables you to specify boards and CPUs to

be blacklisted.

Control Power Displays a window that enables you to use

the power (1M) command. See “To Power

Components On or Off From Within

Hostview” on page 45.

Bringup Displays a window that enables you run

bringup(1M) on a domain. See “To Bring

up a Domain From Within Hostview” on

page 64.

Fan Displays a window that enables you run the

fan (1M) command to control the fans

within the platform. See “To Control Fans

From Within Hostview” on page 54.

Configuration Board Enables you to attach and detach system

boards. This feature is described in the Sun
Enterprise 10000 Dynamic Reconfiguration
User’s Guide.

Domain Provides a pull-right menu with several

choices. The menu choices enable you to

create domains, remove domains, rename

domains, obtain the status of domains, and

view the history of domains. A domain

consists of one or more system boards

running the same operating system kernel.

Domains function independently of each

other. Each domain can carry its own

workload and has its own log messages file.

For more information, see “To Create

Domains From Within Hostview” on

page 56 and “To Remove Domains From

Within Hostview” on page 60.
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Terminal netcontool Displays a window that provides a

graphical interface to the

netcon(1M) command, enabling you to

open a network console window for a

domain. This menu item is equivalent to

executing the netcontool(1M) command.

See “netcon and netcontool Windows”

on page 32.

SSP Provides pull-right menu choices that enable

you to display an SSP Window in xterm ,

dtterm , shelltool , or cmdtool format

with a platform or domain as its host.

Choose a domain (by selecting any system

board within that domain) before choosing

this option.

rlogin Provides pull-right menu choices that enable

you to remotely log in to the selected

platform or domain in an xterm , dtterm ,

shelltool , or cmdtool window. Choose a

domain (by selecting any system board

within that domain) before choosing this

option.

View All Domains Displays the boards within all domains, as

well as any boards that are not part of a

domain. (A board can be present without

being part of a domain, although a board

cannot be used when it is not part of a

domain.)

Individual Domains When you select an individual domain, only

the boards within that domain are

displayed. Note that the color of the outline

used to designate a given domain is also

used as the background color for that

domain in the menu. The system board

numbers for the boards that belong to each

domain are shown in square brackets.

Help Topic Provides online help information on several

topics.

TABLE 2-1 Hostview Menu Items (Continued)

Menu Submenu Items Description
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Help Window

When you choose a topic from the Help menu, the Hostview - Help window is

displayed (FIGURE 2-5).

FIGURE 2-5 Hostview Help Window

You can select the desired topic in the upper pane. The corresponding help

information is displayed in the lower pane.

Main Window Buttons

The main Hostview window contains the buttons described below. If an out-of-

boundary condition exists or an error has occurred, one or more of these buttons

turn red.
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The Power button (FIGURE 2-6) displays the Power Control and Status

window, which enables you to view the power status for the platform.

See “To Power Components On or Off From Within Hostview” on

page 45.

FIGURE 2-6 Power Button

The Temperature button (FIGURE 2-7) displays the Thermal Status

window, which enables you to view the temperature status for the boards

and components within the platform. See “To Monitor Thermal

Conditions From Within Hostview” on page 50.

FIGURE 2-7 Temperature Button

The Fan button (FIGURE 2-8) displays the Fan Status window, which

enables you to view the status of the fans within the platform. See “To

Monitor Fans From Within Hostview” on page 52.

FIGURE 2-8 Fan Button
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When certain error conditions occur, the Failure button (FIGURE 2-8) turns red. If you

click a red Failure button, a window is displayed showing the error condition(s) that

have occurred.

FIGURE 2-9 Failure Button

TABLE 2-2 contains the types of error conditions trapped by this mechanism.

Main Window Processor Symbols

In the main window, the shape and background color of a processor symbol indicate

the status of that processor. For example, a diamond on a green background

indicates the processor is running the operating system.

The shape indicates the mode in which the processor is running. The following list

contains the possible modes of the processor.

■ Operating system

■ hpost (1M)

■ download_helpers

■ OBP

TABLE 2-2 Error Conditions

Error Message Description

Host panic recovery

in progress

The operating system on a domain has failed and is recovering.

Heartbeat failure

recovery in progress

The SSP was not receiving updated platform or domain informaiton

as expected.

Arbitration stop

revocery in progress

A parity error or other fatal error has occurred , and the domain is

recovering. See arbitration stop in the glossary.

Host reboot is in

progress

The domain is being manually rebooted.

Power-on-bringup

recovery in progress

The platform and domains failed due to a power outage. Power has

been restored, and the sytem is bringing up the domains.
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■ Unknown program

TABLE 2-3 lists the color scheme of a symbol which indicates the state of a processor.

Hostview Performance Considerations

Each instance of Hostview requires up to 10 Mbytes of the available swap space in

the SSP. Before running multiple copies of Hostview, make sure the SSP has

sufficient swap space available. For example, if you plan to run three instances of

Hostview, make sure you have at least 30 Mbytes of swap space.

TABLE 2-3 Processor Color Scheme

Color State

Green Running

Maroon Exiting

Yellow Prerun (The OS is currently being loaded.)

Blue Unknown

Black Blacklisted (The processor is unavailable to run programs or

diagnostics.)

Red Redlisted (The processor is unavailable to run programs or

diagnostics and its state may not be changed.)

White Present but not configured (The processor is unavailable, but not

blacklisted or redlisted. One example is a board that has been hot-

swapped in, but has not yet been attached to the operating system.)
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netcon and netcontool Windows

Overview of netcon (1M)

The netcon (1M) command is similar to netcontool (1M) except that no GUI

interface is provided, making it more functional for dial-in or other low-speed

network access. Typically, you log in to the SSP machine as user ssp , and enter the

netcon (1M) command in an SSP window. For example:

This action changes the window in which you run the netcon (1M) command into a

netcon (1M) window for the domain specified by the domain_switch (1M)

command. Multiple netcon (1M) windows can be open simultaneously, but only one

at a time can have write privileges to a specific domain. When a netcon (1M)

window is in read-only mode, you can view messages from the netcon (1M)

window, but you cannot enter any commands.

You can specify the netcon (1M) option -g for Unlocked Write permission, -l for

Locked Write permission, -f to force Exclusive Session mode, or -r for read only

mode. See the netcon (1M) man page for an explanation of how netcon (1M)

behaves if you do not specify any of these arguments.

If you have write permission, you can enter commands. In addition, you can enter

special commands prefixed by atilde (~) to perform the functions offered by the

netcontool (1M) window.

Overview of netcontool (1M)

The netcontool (1M) GUI program provides the buttons shown in FIGURE 2-10.

FIGURE 2-10 netcontool GUI Program

ssp% domain_switch domain_name
ssp%
netcon
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TABLE 2-4 explains the netcontool(1M) buttons.

▼ To Display a netcon (1M) Window From a

netcontool (1M) Window

1. Display a netcontool(1M) window, as described in one of the following
procedures:

■ “To Display a netcontool (1M) Window From the Command Line” on page 35

■ “To Display a netcontool (1M) Window From the CDE Front Panel” on page 36

■ “To Display a netcontool (1M) Window From the CDE Workspace Menu” on

page 36

■ “To Display the netcontool (1M) Window From Hostview” on page 36

2. Optionally, configure a netcontool (1M) window as described in “To Configure
the netcontool (1M) Window” on page 37.

TABLE 2-4 netcontool buttons

Button Description

Configure Displays the Console Configuration window. See “To Configure the

netcontool (1M) Window” on page 37 for more information

Connect Displays the netcon (1M) window and initiates the connection

process.

Disconnect Disconnects the console window from the domain and removes the

console window. The netcontool (1M) window is still available so

that you can reconfigure for another connect session.

OBP/kadb Breaks to the OpenBoot™ PROM (OBP) or kadb (1M) programs.

JTAG Toggles the SSP-to-platform connection between a network

connection and a JTAG connection.

Locked Write,
Unlocked Write,
and Exclusive
Write

Request the corresponding mode for the console window. For an

explanation of the meaning of these modes, see “To Configure the

netcontool (1M) Window” on page 37.

Release Write Releases write access and places the console in read only mode.

Status Displays information about all open consoles that are connected to

the same domain as the current session, as well as the connection

type currently used.

Help Displays information about the netcontool (1M) window.

Exit Exits the program and removes the netcon (1M) window if it is still

open.
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3. Click the Connect button in the netcontool (1M) window.

This displays the netcon (1M) window. netcon (1M) attempts to connect to your

default domain, assuming you did not specify a domain in the Console

Configuration window (described in “To Configure the netcontool (1M) Window”

on page 37). If you did specify a domain in the Console Configuration window,

netcon (1M) attempts to connect to that domain.

If no error occurs, the netcon (1M) window is displayed directly beneath the

netcontool (1M) window. Note that these are two separate windows, although

they can affect each other. You can view messages in the console window and, if you

have write permission, enter commands.

▼ To Display a netcon (1M) Window From the

Command Line

1. Log in to the SSP as user ssp .

2. Type:

For more information about the netcon (1M) command options, refer to the

netcon (1M) man page.

▼ To Display a netcon (1M) Window From the

CDE Front Panel

1. From the CDE front panel, select the SSPsubpanel and then select the netcon
option.

2. Specify the domain name when prompted to do so.

▼ To Display a netcon (1M) Window From the

CDE Workspace Menu

1. From the CDE Workspace menu (right click), select the SSPsubmenu and then
select the netcon option.

ssp% domain_switch domain_name
ssp% netcon
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2. Specify the domain name when prompted to do so.

▼ To Exit from a netcon (1M) Window

● Type the following escape sequence (tilde (~) followed by a period) in the
netcon (1M) window:

If you enter the tilde period sequence locally at the SSP workstation or remotely

through a telnet (1) session, your netcon (1M) session is terminated and the

window returns to its previous state. However, if you enter the tilde period sequence

remotely through an rlogin (1) session, the netcon (1M) session is terminated and
the rlogin (1) window is deleted as well. This is because the tilde period sequence

is recognized by rlogin (1) as an exit command. If you want to avoid this behavior,

you can use the sequence ~~., that is tilde tilde period, to exit from a netcon (1M)

window running inside of an rlogin (1) session. For more information about escape

sequences, see the netcon (1M) manual page.

▼ To Display a netcontool (1M) Window From

the Command Line

1. Log in to the SSP as user ssp .

2. Type:

▼ To Display a netcontool (1M) Window From

the CDE Front Panel

1. From the CDE front panel, select the SSPsubpanel and then select the
netcontool option.

2. Specify the domain name when prompted to do so.

# ~.

ssp% domain_switch domain_name
ssp% netcontool &
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▼ To Display a netcontool (1M) Window From

the CDE Workspace Menu

1. From the CDE Workspace menu (right click), select the SSPsubmenu and then
select the netcontool option.

2. Specify the domain name when prompted to do so.

▼ To Display the netcontool (1M) Window From

Hostview

1. Select a board from the domain for which you want to display a netcontool (1M)
window by clicking on that board with the left mouse button.

2. Select Terminal ‰ netcontool .

3. In the netcontool (1M) window, click the Connect button.

The netcontool (1M) window (FIGURE 2-11) is displayed beneath the

netcontool (1M) buttons.

FIGURE 2-11 netcontool Window in Hostview
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▼ To Configure the netcontool (1M) Window

1. Click the Configure button if you want to configure the netcontool (1M) window
before you display a netcon (1M) window.

The Console Configuration window is displayed (FIGURE 2-12).

FIGURE 2-12 netcontool Console Configuration Window

2. Select the session type in the left panel, and the terminal emulation type in the
right panel.
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3. When you are satisfied with the contents of the window, you click Done to accept
the settings and dismiss the window, or click Apply to accept the settings without
dismissing the window.

The following table contains the options in the Console Configuration. window.

TABLE 2-5 Console Configuration

Console Options

Default Session This causes the default type of session to be started. If no other

session is running, the default is unlocked write mode. If any other

session is running, the default is read only mode.

Read Only Session Displays a console window where you can view output from a

domain, but you cannot enter commands.

Unlocked Write

Session

Attempts to display a netcon (1M) window with unlocked write

permission. If this attempt succeeds, you can enter commands into

the console window, but your write permission is taken away

whenever another user requests Unlocked Write, Locked Write, or

Exclusive Session permission for the same domain.

• If another user currently has Unlocked Write permission, it is

changed to read-only permission, and you are granted Unlocked

Write permission.

• If another user currently has Locked Write permission, you
are granted read-only permission.
• If another user currently has Exclusive Session permission, you

are not allowed to display a netcon (1M) window.

• If you are granted Unlocked Write permission and another
user requests Unlocked Write or Locked Write permission,
you are notified and your permission is changed to read
only. You can attempt to reestablish Unlocked Write
permission at any time, subject to the same constraints as
your initial attempt to gain Unlocked Write permission.
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netcon (1M) Communications

netcon (1M) uses two distinct paths for communicating console input/output

between the SSP and a domain: the standard network interface and the CBE
interface. Usually, when the domain is up and running, console traffic flows over the

network. If the local network becomes inoperable, all interactive access to the

domain is lost and, for example, telnet , rlogin , and netcon (1M) sessions hang.

In this case, you can switch to the CBE interface and access the host’s console

window. To perform this switch, use the ~ = command in the netcon (1M) window.

Locked Write Attempts to display a console window with Locked Write

permission.

• If you are granted Locked Write permission, no other user
can remove your write permission unless they request
Exclusive Session permission.
• If another user currently has Locked Write permission, you
are granted read-only permission.
• If another user currently has Locked Write permission, you
are granted read-only permission.
• If another user currently has Exclusive Session permission, you

are not allowed to display a netcon (1M) window.

Exclusive Session Displays a console window with Locked Write permission,

terminates all other open console sessions for this domain, and

prevents new console sessions for this domain from being started.

You can change back to multiple session mode by clicking the

Release Write button to release write access, or by clicking the

Disconnect button to terminate your console session for the domain.

You can also simply quit from the console window (using the

Control menu of the window). You are not granted Exclusive

Session permission if any other user currently has exclusive session

permission.

Terminal Emulation

Type

The netcon (1M) window is brought up in the specified type of

window. The default is xterm (1). dtterm (1) is only available if you

are running the Common Desktop Environment (CDE), otherwise it

is grayed out. You can also use shelltool (1) or cmdtool (1).

TABLE 2-5 Console Configuration

Console Options
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netcon (1M) Message Logging

Certain messages sent from the kernel are not displayed in the syslog messages file,

such as OpenBoot messages, panic messages, and some console messages. The

reason for this is that syslogd (1M) must run on the host to log the messages, and

this is not possible when a panic occurs, nor is it possible at certain times during the

boot sequence. Moreover, panic dumps often fail, so these types of messages may

not even appear in a dump file to help you determine the cause of the failure.

However, you can capture all output displayed on an active netcon (1M) console

through the LOCAL1facility of syslog (1M) and the SSP machine_server (1M).

This functionality is enabled through the /etc/syslog.conf and

$SSPLOGGER/.logger files. When enabled, netcon (1M) session output is recorded

in file $SSPLOGGER/domain_name/netcon , where $SUNW_HOSTNAMEis set to the

hostname for the domain. By default, this functionality is disabled.

▼ To Enable netcon (1M) Logging

1. In the file /etc/syslog.conf , uncomment the local1.debug line.

2. Force syslogd to reread its configuration file:

▼ To Disable netcon (1M) Logging Sessions for

Specific Hosts

Once logging of netcon sessions are enabled as above, logging can be disabled for

specific domains.

● Start netcon_server with the -S flag for a specific domain.

ssp# kill -HUP ’cat /etc/syslog.pid’

ssp% domain_switch domain_name
ssp% netcon_server -r -S &
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The -S flag, to suspend netcon session output, can also be used with bringup ,

which passes the flag on to netcon_server , for example:

Either method disables output for netcon sessions when otherwise enabled with

the syslog.conf and .logger files as above.

▼ To Re-Enable netcon (1M) Logging Sessions for

Specific Hosts

If you have disabled netcon (1M) logging as described in “To Disable netcon (1M)

Logging Sessions for Specific Hosts” on page 40, you can re-enable netcon (1M)

logging.

● Start netcon_server :

ssp% bringup -S

ssp% domain_switch domain_name
ssp% netcon_server -r &
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CHAPTER 3

System Administration Procedures

This chapter describes the Sun Enterprise 10000 system administration procedures.

Also see the man pages in the Sun Enterprise 10000 SSP Reference and SunOS
Reference Manual. For information about standard system administration functions,

see the System Administrator AnswerBook for your version of the Solaris operating

environment.

You can run many Sun Enterprise 10000 system administration procedures on the

SSP by using Hostview and netcontool (1M).

SSP Log Files

When you perform procedures on an SSP, error messages for a particular domain are

logged in the file:

where domain_name is the host name of the domain for which the error occurred.

Error messages for the platform (which are not specific to a domain) are logged in

the file:

The SSP environment variables, such as SSPLOGGER, are described in “Environment

Variables” on page 89.

$SSPLOGGER/domain_name/messages

$SSPLOGGER/messages
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▼ To View a messages File From Within Hostview

1. Select the appropriate board.

■ If you want to view the messages file for a particular domain, select that domain

in the main Hostview window (by clicking on a board from that domain with the

left mouse button).

■ If you want to view the messages file for the platform, make sure that no domain

is selected.

2. Choose SSP Logs from the File menu.

■ The SSP Logs window is displayed (FIGURE 3-1).

FIGURE 3-1 SSP Logs Window

The Domain Name field shows the name of the domain that you selected. The

messages file is displayed in the main panel of the window.
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Power

This section describes how to control the system power resources from within

Hostview or from the command line, to control the peripherals power resources

from the command line, and to monitor the power levels in Hostview.

▼ To Power Components On or Off From Within

Hostview

1. Click the left mouse button to select a board in the main Hostview window.

2. Choose Power from the Control menu.

The Power Control and Status window is displayed (FIGURE 3-2).
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FIGURE 3-2 Power Control and Status Window

The default power (1M) command is displayed in the Command field.

3. Optionally, add options to the power (1M) command.

4. Click the Execute button (or press Return) to run the command.

The results are shown in the main panel of the window.

5. For information about the power (1M) command, click the Help button.

A help window is displayed. See “Help Window” on page 28.

After powering on the necessary components, you can run the bring up command

on the SSP for eachdomain you want to boot. See “To Bring up a Domain From

Within Hostview” on page 64.

If you try to power off the system while any domain is actively running the

operating system, the command fails and a message is displayed in the message

panel of the window. In this case, you have two choices. You can reissue the

command to power off by executing power (1M) command again with the -f (force)

option. Or, you can issue a shutdown (1M) or similar command for the active
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domain(s) to gracefully shut down the processors, and then reissue the power off
command. Using shutdown (1M) ensures that all resources are de-allocated and

users have time to log out before the power is turned off. To use shutdown (1M), you

must be logged in to the domain as superuser.

If the platform loses power due to a power outage, Hostview displays the last state

of each domain before power was lost.

▼ To Resynchronize Hostview With the Platform

After a Power Failure on the Platform

If power is lost on the platform but not the SSP, perform the following step to

resynchronize Hostview with the platform.

● Determine the snmpd process ID, and then kill that process:

▼ To Power System Boards On and Off From the

Command Line

● To power system boards on, type:

where board_list is a list of system boards separated by spaces, such as

3 5 6 .

● To power system boards off, type:

where board_list is a list of system boards separated by spaces, such as

3 5 6 .

ssp% kill -9 snmpd_pid

ssp% power -on -sb board_list

ssp% power -off -sb board_list
Chapter 3 System Administration Procedures 47



▼ To Monitor Power Levels in Hostview

1. Click the Power button (FIGURE 3-3).

FIGURE 3-3 Power Button

The Power Status Display window is displayed (FIGURE 3-4).
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FIGURE 3-4 Power Status Display

In this window, the bulk power supplies are named PS0 through PS7. The system

board power supplies are numbered 0 through 15. The support board power

supplies are named CSB0 and CSB1. The control board power supplies are named

CB0 and CB1.

Power supplies can be colored green, red, or grey. A green power supply is

functioning properly. A red power supply has failed. A grey power supply is not

present.

2. Click on a system board.

The Power Detail window for that board is displayed (FIGURE 3-5).

System board power
supplies (0 through 15)

Bulk power

(both sides)

supplies

Support
board power
supplies
(both sides)

Control
board power
supplies
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FIGURE 3-5 System Board Power Detail Window

The Power Detail window shows the voltage for each of the five power supplies on

the board. The power levels are indicated in volts. The bars give a visual

representation of the relative voltage levels so that you can monitor them more

easily. If a bar is green, the voltage level is within the acceptable range. If a bar is

red, the voltage level is either too low or too high. (Thus, a red bar can be short or

tall.) The bars never grow taller than the height of the window, so voltage levels that

exceed the maximum threshold are displayed as red maximum-height bars.

Similarly, bars never shrink below a minimum height, so voltage levels below the

minimum threshold are displayed as red minimum-height bars.

The only difference between the detail for a system board and the detail for a control

board or support board is the number of power supplies.

Thermal Conditions and Fans

This section describes how to administer the thermal conditions and fans from

within Hostview and how to monitor and to control the fans from within Hostview.

▼ To Monitor Thermal Conditions From Within

Hostview

You can use Hostview to monitor thermal conditions for power supplies, processors,

(ASICs), and other sensors located on system boards, support boards, controller

boards, and the centerplane.

1. Click the Temperature button (FIGURE 3-6).
50 Sun Enterprise 10000 SSP 3.1.1 User Guide • August 1999



FIGURE 3-6 Temperature Button

The Thermal Status Display window is displayed (FIGURE 3-7).

FIGURE 3-7 Thermal Status Display

The centerplane, support boards, control boards, and system boards are shown in

green if their temperatures are in the normal range, and in red otherwise.

2. Click on a component with the left mouse button to see the thermal details about
that component.

The Thermal Detail window for that component is displayed (FIGURE 3-8).
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FIGURE 3-8 System Board Thermal Detail

The left panel of the system board detail shows the temperatures for the five ASICs,

named A0 through A4. The middle panel shows the temperatures for the three

power supplies. The right panel shows the temperatures for the four processors,

named P0 through P3.

The temperatures are displayed in degrees centigrade, and the values are shown

numerically and as vertical bars. The vertical bars are colored green if the

temperature is within the normal range, and red otherwise. The bars never grow

taller than the height of the window, so temperature levels above the maximum

threshold are displayed as red maximum-height bars. Similarly, bars never shrink

below a minimum height, so temperature levels below the minimum threshold are

displayed as red minimum-height bars.

The detail windows for control boards, support boards, and the center plane are

similar.

▼ To Monitor Fans From Within Hostview

You can use Hostview to monitor fan speeds and fan failures for the 32 fans located

throughout the Sun Enterprise 10000 system platform.

1. Click on the Fan button (FIGURE 3-9).
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FIGURE 3-9 Fan Button

The Fan Status Display window is displayed (FIGURE 3-10).

FIGURE 3-10 Fan Status Display

The fan trays are named FT0 through FT7 on the back, and FT8 through FT15 on the

front. Each fan tray contains two fans. The color of the fan tray symbol is green if

both fans in the tray are functioning at normal speed, amber if both fans are

functioning at high speed, and red if either fan within the fan tray has failed.

2. Click on a fan tray symbol with the left mouse button to see a detail window
about that fan.

The Fan Tray window is displayed (FIGURE 3-11).
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FIGURE 3-11 Fan Tray Window

The top circle indicates the inner fan when you open the fan tray, and the lower

circle indicates the outer fan. The color surrounding each circle in the fan detail

indicates the status of that fan. The colors are green for normal operation at normal

speed, amber for normal operation at high speed, and red for failure.

▼ To Control Fans From Within Hostview

You can control fan power and speed from within Hostview.

1. Choose Fan from the Control menu.

The Fan Control and Status window is displayed (FIGURE 3-12).
54 Sun Enterprise 10000 SSP 3.1.1 User Guide • August 1999



FIGURE 3-12 Fan Control and Status Window

The Domain Name field shows the selected domain from the platform to which

Hostview is connected. The fan (1M) command is shown in the Command field

without any options.

2. Add the desired set of options to the fan (1M) command, and click the execute
button (or press Return).

For example, if you want to set the fans on the front fan shelves to high speed, type:

For information on the fan (1M) command, click the Help button. A help window is

displayed (see “Help Window” on page 28). Or, refer to the fan (1M) man page.

fan -s fast
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Domains

The SSP supports commands that let you logically group system boards into

Dynamic System Domains, or simply domains, which are able to run their own

operating system and handle their own workload. Domains can be created and

deleted without interrupting the operation of other domains. You can use domains

for many purposes. For example, you can test a new operating system version or set

up a development and testing environment in a domain. In this way, if problems

occur, the rest of your system is not affected. You can also configure several domains

to support different departments, with one domain per department. In this situation,

you might reconfigure the system into one domain to run a large job over the

weekend.

Domain Configuration Requirements

You can create a domain out of any group of system boards, provided the following

conditions are met:

■ The boards are present and not in use in another domain.

■ At least one board has a network interface.

■ The boards have sufficient memory to support an autonomous domain.

■ The name you give the new domain is unique (as specified in the

domain_create (1M) command) and this name matches the host name of the

domain to be booted (as specified by the SUNW_HOSTNAMEenvironment variable).

■ You have an eeprom.image file for the domain that was shipped to you by the

factory. If your eeprom.image file has been accidentally deleted or corrupted

and you do not have a backup, see “To Recreate the eeprom.image File” on

page 59.

There must be at least one boot disk connected to one of the boards that will be

grouped together into a domain. Alternatively, if a domain does not have its own

disk, there must be at least one network interface so that you can boot the domain

from the network.

▼ To Create Domains From Within Hostview

Note – Before proceeding, read the requirements in the previous section, “Domain

Configuration Requirements” on page 56. If the system configuration must be

changed to meet any of these requirements, call your service provider.
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1. Click the left mouse button on the first board.

2. Click the middle mouse button on any additional boards.

Ensure that the boards you select do not currently belong to any domain.

3. Choose Domain then Create from the Configuration menu.

The Create Domain window is displayed (FIGURE 3-13).

FIGURE 3-13 Create Domain Window

Caution – You must be sure to specify the proper OS Version number for the

domain you are creating. The default is 2.5.1. Edit this version number, if necessary,

to reflect the version of the operating system for the domain you are creating.
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4. Type the domain name.

The name of the domain will be given to you by the factory. It cannot be an arbitrary

name.

5. If all other fields are acceptable, click execute.

Note that the System Boards field indicates the boards that you selected in the main

Hostview window. The default OS version and the default platform type are shown.

If Hostview successfully executes the command, it displays the message Command
completed in the informational panel of the window.

Note – Hostview can run only one create or remove command at a time. If you

attempt to execute a second create or remove command before the first has

completed, your second attempt fails.

▼ To Create Domains From the Command Line

Note – Before proceeding, see “Domain Configuration Requirements” on page 56. If

the system configuration must be changed to meet any of these requirements, call

your service provider.

1. Type domain_create (1M) in an SSP window.

where:

domain_name is the name you want to give to the new domain. It should be unique

among all Sun Enterprise 10000 systems controlled by the SSP.

system_board_list specifies the boards that are to be part of this domain. The specified

system boards must be present and not in use. Each domain must have a network

interface, SCSI interface, and sufficient memory to support an autonomous system.

List the board numbers, separated by commas or spaces, for all boards you want to

include.

os_version is the version of the operating system to be loaded into the domain.

platform_name is the name of the platform managed by the SSP.

ssp% domain_create -d domain_name -b system_board_list  \
-o os_version -p platform_name
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2. Optionally, create a new SSP window for the domain, as described in “SSP
Window” on page 16.

Use the domain_switch (1M) command to set the SUNW_HOSTNAMEenvironment

variable to the new domain name.

▼ To Recreate the eeprom.image File

Note – You cannot create a domain if you do not have the corresponding

eeprom.image file. The eeprom.image files for the domains you ordered are

shipped to you by the factory. If you accidentally delete an eeprom.image file or

your boot disk is corrupted, and you do not have a backup copy of your

eeprom.image file, you can contact your Sun service representative to recreate it.

Alternatively, you may be able to recreate the eeprom.image file if you have the

original serial number and the EEPROM key. In this case, follow the steps in this

procedure.

1. Log in to the SSP as user ssp .

2. Recreate the eeprom.image file.

Note – All key and host_id numbers are case sensitive and must be entered

exactly as they are received.

a. For the first domain, type:

where:

domain_name is the hostname of the domain.

key is the eeprom key number.

serial_number is the number provided with the key in the form of 0XA65xxx.

ssp% domain_switch domain_name
ssp% sys_id -k key -s serial_number
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b. For all subsequent domains, type:

where:

domain_name is the hostname of the domain.

key is the eeprom key number.

hostid is the number provided with the key in the form of 0X80A66xxx.

3. Check the result by typing:

In the following example, 49933C54C64C858CD4CF is the key and 0x80a66e05 is the

hostid:

4. Back up the SSP eeprom.image files to tape or disk where they can be accessed
in case of SSP boot disk failure.

▼ To Remove Domains From Within Hostview

1. In the main Hostview window, click any board in the domain to be removed.

2. Choose Domain then Remove from the Configuration menu.

The Remove Domain window is displayed (FIGURE 3-14).

ssp% domain_switch domain_name
ssp% sys_id -k key -h hostid

ssp% sys_id -d

ssp% domain_switch domain_name
ssp% sys_id -k 49933C54C64C858CD4CF -h 0x80a66e05
ssp% sys_id -d

 IDPROM in eeprom.image. domain_name

                    Format = 0x01
              Machine Type = 0x80
          Ethernet Address = 0:0:be:a6:6e:5
        Manufacturing Date = Wed Dec 31 16:00:00 1998
Serial number (machine ID) = 0xa66e05
                  Checksum = 0x3f
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FIGURE 3-14 Remove Domain Window

3. If the default domain_remove (1M) command is satisfactory, click the execute
button; otherwise, edit the command first.

For help on the domain_remove (1M) command, click the help button. A help

window is displayed (see “Help Window” on page 28).

4. Specify whether or not domain subdirectories should be removed when you are
prompted to do so.

The pathnames of the subdirectories are displayed. These subdirectories contain

domain-specific information such as message files, configuration files, and

hpost (1M) dump files. You can keep these directories if you still need the

information. It is easier to recreate a domain later if you keep these directories.

Note – If the system cannot remove your domain, see domain_remove (1M) for a

list of potential errors.
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▼ To Remove Domains From the Command Line

1. Type domain_remove (1M).

You must execute this command in an SSP window whose environment variable

SUNW_HOSTNAMEis set to the name of the domain you want to remove. The domain

must not be running the operating system.

2. Specify whether or not domain subdirectories should be removed when you are
prompted to do so.

The pathnames of the subdirectories are displayed. These subdirectories contain

domain-specific information such as message files, configuration files, and

hpost (1M) dump files. You can keep these directories if you still need the

information. The domain can be recreated whether or not you keep this information.

3. Type domain_status (1M) to verify that the domain was removed.

Note – If the system cannot remove your domain, an error message is displayed.

See domain_remove (1M) for a list of potential errors.

▼ To Rename Domains From Within Hostview

Note – After you rename a domain, you must also update /etc/hosts to reflect

the domain’s new name.

1. Shut down the domain.

2. In the main Hostview window, select a board from the domain that you want to
rename by clicking on it with the left mouse button.

3. Choose Domain then Rename from the Configuration menu.

The Rename Domain window is displayed (FIGURE 3-15).

ssp% domain_remove -d domain_name
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FIGURE 3-15 Rename Domain Window

4. If the default domain_rename (1M) command is satisfactory, click the execute
button. Otherwise, edit the command first.

For help on the domain_rename (1M) command, click the help button. A help

window is displayed (see “Help Window” on page 28).

▼ To Rename Domains From the Command Line

Note – After you rename a domain, you must also update the standard host

configuration files to reflect the domain’s new name. See the Solaris 2.x User
Collection and Solaris 2.x System Administrator AnswerBook.
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● Use the domain_rename (1M) command.

For more information, see the domain_rename(1M) , domain_remove(1M) , and

domain_create(1M) commands.

▼ To Bring up a Domain From Within Hostview

1. Select the domain you want to bring up.

In the domain you want to bringup, click on any system board.

2. Choose Bringup from the Control menu.

A window is displayed that shows the name of the selected domain.

3. Click Execute to perform the bringup.

4. After the bringup operation has completed, choose netcontool from the Terminal
menu.

5. Click the Connect button to open a netcon (1M) window.

6. If the OBP prompt appears (that is, the OKprompt), boot the domain:

The domain should boot and then display the login prompt. Note that you can use

the OBP command devalias to determine the alias for the disk you want to use as

boot_device.

▼ To Bring up a Domain From the Command Line

Ensure that the SUNW_HOSTNAMEis set to the proper domain before proceeding. If it

is not, you will need to switch it.

% domain_rename -d old_domain_name -n new_domain_name

OK boot boot_device
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1. Type:

where domain_name is the name of the domain you want to bring up.

Before you can bring up a domain from the command line in an SSP window, the

system boards for the domain must be powered on.

2. Power on the power supplies for all of the boards in the domain:

where board_list is a list of system board numbers separated by spaces.

3. Bring up the domain by typing the following commands:

The -A option is the autoboot option. If the autoboot option is on, the domain will

automatically boot. If it is off, you need to explicitly boot the domain.

▼ To Obtain Domain Status From Within Hostview

● Choose Domain then Status from the Configuration menu.

The Domain Status window is displayed (FIGURE 3-16).

ssp% domain_switch domain_name

ssp% power -on -sb board_list

ssp%bringup -A [off/on] [ disk]
ssp% netcon
ok boot
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FIGURE 3-16 Domain Status Window

The status listing is displayed in the main panel of the window. The following table

explains the columns in the Domain Status window.

TABLE 3-1 Domain Status Columns

Name Description

DOMAIN Lists the name of the domain.

TYPE Lists the platform type. It can only have the value

Ultra-Enterprise-10000 in the current release.

PLATFORM Lists the name of the platform. The platform name is set at the time

the SSP packages are installed.

OS Lists the operating system version for the domain.

SYSBDS Lists the system boards that make up the domain.
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Blacklisting Components

The blacklisting feature enables you to configure the following components out of

the system:

■ System boards

■ Processors

■ Address buses

■ Data buses

■ Data routers

■ I/O controllers

■ I/O adapter card

■ System board memory

■ Memory DIMM groups

■ Sun Enterprise 10000 half-centerplane

■ Port controller ASICs

■ Data buffer ASICs

■ Coherent interface controller ASICs

■ 72-bit half of 144-bit, local, data router within system boards

Generally, you may want to blacklist a component if you believe that component is

having intermittent problems, or if it is failing sometime after the system is booted.

If a component has a problem that shows up in the power-on self-test (POST) run by

hpost (1M) (which is run by the bringup (1M) command), that component is

automatically configured out of the system by hpost (1M). However, that

component is not blacklisted. hpost (1M) is run on the components in the system

before a domain is booted, and on the components on a given board before that

board is attached with Dynamic Reconfiguration (DR). See the Dynamic
Reconfiguration User’s Guide.

To blacklist a component, you can edit the blacklist (4) file with a text editor, or

use Hostview. Hostview does not allow you to blacklist all possible components, so

there may be times when you need to edit blacklist (4) directly. When a domain

runs POST, hpost (1M) reads the blacklist (4) file and automatically excludes the

components specified in that file. Thus, changes that you make to the blacklist (4)

file do not take effect until the domain is rebooted.

The file is $SSPVAR/etc/ platform_name/blacklist , where platform_name is the

name of the platform. See the blacklist (4) man page for information about the

contents of the blacklist (4) file.
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▼ To Blacklist Components From Within Hostview

1. Choose Blacklist File from the Edit menu.

The Blacklist Edit window is displayed (FIGURE 3-17).

FIGURE 3-17 Blacklist Edit Window—Board View

2. Select the boards and/or buses that you want to place onto the blacklist.

To select a single component and deselect all other components of that type (for

example, to select a single board and deselect all other boards), click on that

component with the left mouse button. To toggle the selection status of a single

component without affecting the selection status of any other component, click on

that component with the middle mouse button. The selected components are

displayed in black.
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3. To save the changes, choose Save from the File menu.

4. To exit the Blacklist Edit window, choose Close from the File menu.

If you have unsaved changes and you close the Blacklist Edit window by choosing

Close from the File menu, you are prompted to save the changes.

▼ To Blacklist Processors From Within Hostview

1. Choose Blacklist File from the Edit menu.

The Blacklist Edit window is displayed.

2. From the Blacklist Edit window, choose Processors from the View menu.

The Blacklist Edit window displays the Processor View window (FIGURE 3-18).
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FIGURE 3-18 Blacklist Edit Window—Processor View

3. Select the processors that you want to add to the blacklist.

To select a single processor on a board and deselect all other processors on that

board, click on that processor with the left mouse button. To toggle the selection

status of a processor on a board without affecting the selection status of any other

processors on that board, click on that processor with the middle mouse button. The

selected processors are displayed in black.

4. To save the changes, choose Save from the File menu.

5. To exit the Blacklist Edit window, choose Close from the File menu.

If you have unsaved changes and you close the Blacklist Edit window by choosing

Close from the File menu, you are prompted to save the changes.
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▼ To Clear the Blacklist File From Within

Hostview

1. In Hostview, choose Blacklist File from the Edit menu.

2. From the Blacklist Edit window, choose New from the File menu.

3. From the Blacklist Edit window, choose Close from the File menu.

Using a Spare SSP

The SSP unit is a Sun workstation with a defined hardware configuration. Any

identical Sun workstation can also serve as an SSP. You can optionally designate

such a Sun workstation as a spare SSP unit, to serve as a backup if your main SSP

unit fails. You can also order your Sun Enterprise 10000 system server with a spare

SSP unit.

Maintain a spare SSP in a ready state. This allows you to quickly switch to the spare

SSP if the main SSP fails. Do not run any software on the spare SSP machine other

than the SSP software. (If you are using clusters, you can run the Sun cluster console

on the main SSP.)

To maintain a spare SSP, you must adhere to the following requirements:

■ The spare SSP must be properly configured to function in the same way as the

main SSP within the network.

■ You must not install or use any non-SSP software on it (except for possibly the

Sun cluster console).

■ Any changes that you make to the main SSP must be made to the spare SSP as

well. After any system configuration operation, you must immediately run the

ssp_backup script on the main SSP. The ssp_backup script backs up the SSP

configuration environment only. It does not back up the entire file system. If the

main SSP crashes, you will have a backup file that you can restore to the spare

SSP by running the ssp_restore script. The ssp_restore script restores the

SSP configuration environment only. It does not restore the entire file system. For

more information about the ssp_backup and ssp_restore scripts, see “To

Switch Between the Main and Spare SSP” on page 72.

Note – You can run any combination of SSP versions 3.1 and 3.1.1 on the main and

spare SSP machines. However, you cannot run SSP 3.0 on either the main or the

spare if you are also using SSP 3.1.1.
Chapter 3 System Administration Procedures 71



▼ To Switch Between the Main and Spare SSP

1. Change the main SSP to a spare SSP:

a. Log in to the main SSP as root .

b. Type:

This command backs up the SSP configuration information to the file

backup_dir/ssp_backup.cpio .

c. Type:

d. If this SSP is running the SSP 3.1 software, halt the SSP or kill the rarpd
process.

2. Change the spare SSP to a main SSP:

a. Log in to the spare SSP as root.

b. Transfer the ssp_backup.cpio file that you created in Step 1 to a backup
directory on the spare SSP.

c. Type:

Note – The SSP environment should not be changed between the time you run

ssp_backup and ssp_restore . For example, after you run ssp_backup , you

should not shut down a domain, bring up a domain, or power boards on or off until

you run ssp_restore .

ssp# /opt/SUNWssp/bin/ssp_backup backup_dir

ssp# /opt/SUNWssp/bin/ssp_config
Beginning setup of this workstation to act as a MAIN or SPARE SSP.
Are you currently configuring the MAIN SSP? (y/n)n
SPARE SSP configuration completed.
ssp#

ssp# /opt/SUNWssp/bin/ssp_restore backup_dir/ssp_backup.cpio
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d. Type:

e. If this SSP is running the SSP 3.1 software, reboot the SSP.

3. For each domain on the host, perform the following steps.

If a domain is down when you perform this procedure, the console window may be

unusable after the domain is brought up by the spare SSP. If the console window is

unusable perform these steps using an rlogin or telnet session.

a. From the new main SSP, or from another workstation on the network, remotely
login to the domain as root.

b. Edit the /etc/ssphostname file to replace the hostname of the main SSP with
the hostname of the spare SSP.

For example, if your main SSP is called xf4-ssp and your spare SSP is called

xf4-ssp2 , then you would change the contents of /etc/ssphostname to

xf4-ssp2 .

c. Switch console communication from the main SSP to the spare SSP by typing:

where cvcd_path is /sbin under the Solaris 2.5 and 2.6 operating environments,

and cvcd_path is /platform/SUNW,Ultra-Enterprise-10000/lib/cvcd
under the Solaris 7 operating environment.

d. If needed, update the /etc/syslog.conf file to replace the hostname of the
main SSP with the hostname of the spare SSP.

ssp# /opt/SUNWssp/bin/ssp_config spare
Configuring the spare SSP to control the Host

Beginning set up of the SPARE SSP workstation to control the host.

Platform name = allxf4
Control board 0 = xf4-cb0 => 129.153.151.123
Control board 1 = xf4-cb1 => 129.153.152.123
Primary Control Board = 0

Is this correct? (y/n)y

This SPARE SSP is NOW configured to control the host.

This machine is the MAIN SSP now.

# ps -ef | grep cvcd
# kill -9 cvcd_pid
# cvcd_path/cvcd
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Dual Control Board Handling

A platform can be configured with dual control boards for redundancy purposes.

Although you can manually switch between the control boards, only one control

board at a time is used by the system.

One of the control boards is identified as the primary control board. The SSP

attempts to communicate only with the primary control board. If the system

administrator decides that it is necessary to switch the primary control board

because of a connection failure or for other reasons, the system administrator must

modify the control board configuration file and reboot the SSP to activate the new

primary control board. Note that this operation cannot be performed without

rebooting all running domains because the control board provides the system clocks

for all boards.

Control Board Executive

The control board executive (CBE) runs on the control board and facilitates

communication between the SSP and the platform.

When power is applied, both control boards boot from the SSP that is serving as the

boot server. After the CBE is booted, it waits indefinitely for the control board server

running on the SSP to establish a connection.

Primary Control Board

When the control board server running on the SSP connects to the CBE running on a

control board, the CBE asserts the control board as the primary control board. The

primary control board is responsible for providing the system clock and JTAG clock

and for controlling fan trays and bulk power supplies.

Control Board Server

After the SSP is booted, the control board server (CBS), is started automatically. The

CBS is responsible for all communication between the SSP and the primary control

board.
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The CBS attempts to connect only to the primary control board identified in the

control board configuration file. The format of the file is as follows:

where:

platform_name is the name assigned by the system administrator.

platform_type is defaulted to Ultra-Enterprise-10000 .

cb0_hostname is the host name for control board 0, if available.

status0 indicates that control board 0 is the primary control board (P indicates

primary, and anything else indicates nonprimary).

cb1_hostname is the host name for control board 1, if available.

status1 indicates that control board 1 is the primary control board.

For example:

This example indicates that there are two control boards in the xf2 platform. They

are xf2-cb0 and xf2-cb1 . xf2-cb0 is specified as the primary. See the

cb_config (4) man page for more information.

The communication port that is used for communication between the control board

server and the control board executive is specified in /tftpboot/
xxxxxxxx.cb_port where xxxxxxxx is the control board IP address represented

in hexadecimal format.

Control Board Executive Image and Port Specification Files

The SSP is the boot server for the control board. Two files are downloaded by the

control board boot PROM during boot time: the image of CBE and the port number

specification file. These files are located in /tftpboot on the SSP and the naming

conventions are:

where xxxxxxxx is the control board IP address in hex format.

platform_name: platform_type: cb0_hostname: status0: cb1_hostname: status1

xf2:Ultra-Enterprise-10000:xf2-cb0:P:xf2-cb1:

/tftpboot/xxxxxxxx for the cbe image
/tftpboot/xxxxxxxx.cb_port for the port number
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For example, the files for control board xf2-cb0 are:

If you are using NIS, the IP address of xf2-cb0 can be determined as follows:

The returning address is 129.153.49.147. This can be converted to 81993193.

▼ To Switch the Primary Control Board

Caution – Do not edit the /var/opt/SUNWssp/.ssp_private/cb_config file

manually. Instead, use the ssp_config (1M) command as described below.

Otherwise, your domains may fail and arbitration stops (arbstops) may occur.

1. If any domains are running, shut down those domains using the standard
shutdown (1B) command.

2. Log in to the main SSP as ssp .

3. Power off all of the system boards.

4. Power on all of the system boards.

5. Log in to the main SSP as superuser .

6. Obtain the host names and IP addresses for the two control boards.

7. Verify that control board IP addresses are set up properly in the
/etc/inet/hosts file or in your local name service system.

/tftpboot/81973213
/tftpboot/81973213.cb_port

% ypcat hosts | grep xf2-cb0

ssp% power -off -all

ssp% power -on -all
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8. As superuser, typessp_config (1M) as shown in the following sample session.

In this sample session, the primary control board is switched from snax-cb0 to

snax-cb1 .

Note – The platform name identifies the entire host machine, not a particular domain.

9. Restart the main SSP processes.

a. As superuser, type:

b. Log in to the SSP as user ssp .

 ssp# /opt/SUNWssp/bin/ssp_config cb

Configuring control boards.

Platform name   = snax
Control Board 0 = snax-cb0 => 129.153.49.181
Control Board 1 = snax-cb1 => 129.153.49.182
Primary Control Board = 0

Is this correct? (y/n): n
Do you have a control board 0? (y/n): y
Please enter the host name of the control board 0 [snax-cb0]:
Do you have a control board 1? (y/n): y
Please enter the host name of the control board 1 [snax-cb0]:

Please identify the primary control board.
Is Control Board 0 [snax-cb0] the primary? (y/n) n
Is Control Board 1 [snax-cb1] the primary? (y/n) y

Platform name   = snax
Control Board 0 = snax-cb0 => 129.153.49.181
Control Board 1 = snax-cb1 => 129.153.49.182
Primary Control Board = 1

Is this correct? (y/n): y

ssp# /etc/init.d/ssp stop
ssp# /etc/init.d/ssp start
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c. Type:

d. Wait until you see the following message:

10. Start Hostview:

Verify that the “J” and “C” symbols are shown on the symbol for Control Board 1 in

the main Hostview screen. This indicates that the JTAG connection and clock

distribution signals are coming from Control Board 1.

If Hostview fails to respond, verify that you can communicate with Control Board 1.

If you are unable to use ping (1M) to communicate with Control Board 1, visually

examine the LEDs to verify that the control board is operating correctly. For

example, verify that the link integrity LED is on. This indicates that the Ethernet

connection is good. If the LEDs are cycling through a pattern, the control board is

booted. If the LEDs are all off or all on continuously (without cycling through a

pattern), the control board is not booted. Try running snoop (1M) on the SSP to

verify that the control boards are communicating correctly.

11. If you have a spare SSP, repeat Step 6 through Step 8 above, on the spare SSP.

12. Issue the bringup (1M) command for all domains.

ssp% tail -f $SSPLOGGER/messages

Startup of SSP programs complete

ssp% hostview &
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CHAPTER 4

SSP Internals

SSP operations are generally performed by a set of daemons and commands. This

chapter provides an overview of how the SSP works and describes the SSP daemons,

processes, commands, and system files. For more information about daemons,

commands, and system files, refer to the Sun Enterprise 10000 SSP Reference.

Caution – Changes made to files in /opt/SUNWssp can cause serious damage to

the system. Only very experienced system administrators should risk changing the

files described in this chapter.

Startup Flow

The sequence of events that take place when the SSP boots and starts the Sun

Enterprise 10000 system are given in the following list.

1. The user powers on the SSP.

The SSP boots automatically and powers on the monitor, CPU and disk(s), and

the CD-ROM.

The /etc/rc2.d/S99ssp startup script is called when the system enters run

level 2.

This script starts ssp_startup .

The ssp_startup script starts the SSP daemons.

machine_server , fad , cbs , straps , snmpd, and edd .

It also calls cb_reset to start control board initialization.
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The edd daemon initiates event monitoring on the Sun Enterprise 10000 system

control board, waits for an event to be generated by the event detection task

running on the control board, and then responds to the event by running a

response action script on the SSP.

2. The user applies power to platform or domain.

Set SUNW_HOSTNAMEto the domain name by running the command

domain_switch domain_name.

3. The user executes domain_create .

You need to do this only once for each domain.

4. The system executes bringup .

bringup verifies that the operating system is running, runs POST, then runs

obp_helper , which runs OBP, and starts netcon_server(1M) .

The system optionally loads the operating system and the boot process is

complete.

The SSP monitors the Sun Enterprise 10000 system using the event detector

daemon, edd (1M). Each time the SSP boots, it runs /etc/rc2.d/S99ssp which

in turn loads edd (1M) through the startup script, $SSPETC/ssp_startup.sh .

The startup script checks the environment for availability of certain files and the

availability of the Sun Enterprise 10000 system, sets environment variables, and

then starts edd (1M). edd (1M) obtains many of its initial control parameters from

the following configuration files:

■ $SSPVAR/etc/ platform_name/edd.erc provides configuration information

for the Sun Enterprise 10000 system platform.

■ $SSPVAR/etc/ platform_name/ domain_name/edd.erc provides configuration

information for a particular domain. The event response configuration files

(edd.erc ) specify how the event detector will respond to events.

■ $SSPVAR/etc/ platform_name/edd.emc lists the events that edd (1M) will

monitor.

If a domain crashes, edd (1M) invokes the bringup (1M) script. The bringup (1M)

script runs the POST program, which tests Sun Enterprise 10000 system

components. It then uses the obp_helper (1M) daemon to download and begin

execution of OBP in the domain specified by the SUNW_HOSTNAMEenvironment

variable. This only happens if a domain fails (for example, after a kernel panic) in

which case it is rebooted automatically. After a halt or shutdown, you must

manually run bringup (1M), which then causes OBP to be downloaded and run.

obp_helper (1M) is responsible for loading download_helper in all the

configured processors’ bootbus SRAM. All the processors are started, with one

processor designated the boot processor. With the assistance of
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download_helper , obp_helper (1M) loads OBP into the memory of the Sun

Enterprise 10000 system and starts OBP on the boot processor. See “OBP

Daemon” on page 88 for more information about obp_helper (1M) and OBP.

The primary task of OBP is to boot and configure the operating system from

either a mass storage device or from a network. OBP also provides extensive

features for testing hardware and software interactively. As part of the boot

procedure, OBP probes all the SBus slots on all the system boards and builds a

device tree. This device tree is passed on to the operating system.

Sun Enterprise 10000 Client/Server
Architecture

The Sun Enterprise 10000 system control board interface is accessed over an Ethernet

connection using the TCP/IP protocol. The control board executive, CBE , runs on

the control board and the control board server, CBS (using the cbs (1M) command),

runs on the SSP and makes service requests. The SSP control board server provides

services to SSP clients.

FIGURE 4-1 illustrates the Sun Enterprise 10000 system client/server architecture:
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FIGURE 4-1 Sun Enterprise 10000 Client/Server Architecture

Note – There is one instance of edd (1M) for the platform supported by the SSP.

There is one instance of obp_helper (1M) and netcon_server (1M) for each

domain on the platform.

POST

POST probes and tests the components of uninitialized Sun Enterprise 10000 system

hardware, configures what it deems worthwhile into a coherent initialized system,

and hands it off to OpenBoot PROM (OBP). POST passes to OBP a list of only those

components that have been successfully tested; those in the blacklist (4) file are

excluded.

SE 10000 Platform

SSP

CBS

Domain
Control
Board

netcon_server snmpd obp_helper

netcon edd posthostview
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hpost (1M) is the SSP-resident executable program that controls and sequences the

operations of POST. hpost (1M) reads directives in the optional file .postrc (see

postrc (4)) before it begins operation with the host.

Caution – Running hpost (1M) outside of the bringup (1M) command can cause

the system to fail. hpost (1M), when run by itself, does not check the state of the

platform, and causes fatal resets.

POST looks at blacklist (4), which is on the SSP, before preparing the system for

booting. blacklist (4) specifies the Sun Enterprise 10000 system components that

POST must not configure.

POST stores the results of its tests in an internal data structure called a board
descriptor array. The board descriptor array contains status information for most of

the major components of the Sun Enterprise 10000 system, including information

about the UltraSPARC™ modules.

POST attempts to connect and disconnect each system board, one at a time, to the

system centerplane. POST then connects all the system boards that passed the tests

to the system centerplane.

Daemons

The SSP daemons play a central role on the SSP. Each daemon is fully described in

its corresponding man page. The following table briefly describes the daemons:

TABLE 4-1 Daemons

Name Description

cbs The control board server provides central access to the Sun

Enterprise 10000 system control board for client programs running

on the SSP.

edd The event detector daemon initiates event monitoring on the control

boards. When a monitoring task detects an event, edd (1M) runs a

response action script.

fad The file access daemon provides distributed file access services to

SSP clients that need to monitor, read, and write to the SSP

configuration files.

machine_server Provides machine services for netcon (1M) and routes host

messages to proper messages file. See machine_server (1M).
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Event Detector Daemon

The event detector daemon, edd (1M), is a key component in providing the

reliability, availability, and serviceability (RAS) features of Sun Enterprise 10000

system. edd (1M) initiates event monitoring on the Sun Enterprise 10000 system

control board, waits for an event to be generated by the event detection monitoring

task running on the control board, and then responds to the event by executing a

response action script on the SSP. The conditions that generate events and the

response taken to events are fully configurable.

The edd (1M) provides the mechanism for event management, but does not handle

the event detection monitoring directly. Event detection is handled by an event

monitoring task that runs on the control board. edd (1M) configures the event

monitoring task by downloading a vector that specifies the event types to be

monitored. Event handling is provided by response action scripts, which are

invoked on the SSP by the edd (1M) when an event is received.

netcon_server The connection point for all netcon (1M) clients.

netcon_server (1M) communicates with OBP using a control

board protocol. netcon_server (1M) communicates with the OS

using the TCP protocol.

obp_helper Runs OpenBoot. obp_helper (1M) terminates when OBP is

terminated. During execution, obp_helper (1M) provides services

to OBP, such as NVRAM simulation, IDPROM simulation, and time

of day.

snmpd The SNMP proxy agent listens to a UDP port for incoming requests

and services the group of objects specified in

Ultra-Enterprise-10000.mib .

straps The SNMP trap sink server listens to the SNMP trap port for

incoming trap messages and forwards received messages to all

connected clients.

xntpd / ntpd The network time protocol (NTP) daemon provides time

synchronization services. (xntpd is the daemon for the Solaris 2.5.1

operating environment, and ntpd is the daemon for the Solaris 2.6

and Solaris 7 operating environments.) Clients can connect to this

service and have their clocks automatically adjusted. This service is

used to synchronize SSP and domain times. See xntpd (1M) and the

Network Time Protocol User’s Guide.

TABLE 4-1 Daemons (Continued)

Name Description
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The RAS features are provided by several collaborative programs. The control board

within the platform runs a control board executive (CBE) program that

communicates by Ethernet with a control board server (cbs (1M)) program on the

SSP. These two components provide the data link between the platform and the SSP.

The SSP provides a set of interfaces for accessing the control board through the

control board server and the simple network management protocol (SNMP) agent.

edd (1M) uses the control board server interface to configure the event detection

monitoring task on the control board executive (FIGURE 4-2).

FIGURE 4-2 Uploading Event Detection Scripts

After it is configured, the event detection monitoring task polls various conditions

within the platform, including environmental conditions, signature blocks, power

supply voltages, performance data, and so forth. If an event detection script detects

a change of state that warrants an event, an event message containing the pertinent

information is generated and delivered to the control board server (cbs (1M))

running on the SSP. Upon receipt of the event message, the control board server

delivers the event to the SNMP Agent, which in turn generates an SNMP trap

(FIGURE 4-3).

FIGURE 4-3 Event Recognition and Delivery
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Upon receipt of an SNMP trap, edd (1M) determines whether to initiate a response

action. If a response action is required, the edd (1M) runs the appropriate response

action script as a subprocess (FIGURE 4-4).

FIGURE 4-4 Response Action

Event messages of the same type or related types can be generated while the

response action script is running. Some of these secondary event messages may be

meaningless or unnecessary if a responsive action script is already running for a

similar event. For instance, edd (1M) is running a response action script for a high-

temperature event. While the response action script is running, additional high

temperature events can be generated by the event monitoring scripts. edd (1M) does

not respond to those high temperature events (generated in response to the same

high temperature condition) until the first response script has finish. It is the

responsibility of applications (such as edd (1M)) to filter the events they will respond

to as necessary. The cycle of event processing is completed at this point.

Control Board Server

The control board server (CBS) is a server that runs on the SSP. Whenever a client

program running on the SSP needs to access the Sun Enterprise 10000 system, the

communication is funneled through cbs (1M). cbs (1M), in turn, communicates

directly with CBE running on one of the control boards in the Sun Enterprise 10000

system. cbs (1M) converts client requests to the control board management protocol

(CBMP) that is understood by CBE. The following diagram (FIGURE 4-5) shows how

the CBS and CBEs are connected.
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FIGURE 4-5 CBS Communication Between SSP and Sun Enterprise 10000 system

cbs (1M) relies on the cb_config (4) file to determine the platform it is to manage,

and the control board with which it is to interact. The cb_config (4) file specifies

the platforms managed by the SSP. You should not modify this file.

File Access Daemons

The file access daemon (fad (1M)) is used when ssp_to_domain_hosts (4) or any

other configuration file is updated. fad (1M) provides distributed file access services,

such as file locking, to all SSP clients that need to monitor, read, and write changes

to SSP configuration files. Once a file is locked by a client, other clients are prevented

from locking that file until the first client releases the lock.

Network Time Protocol Daemon

The NTP daemon (which is xntpd (1M) for the Solaris 2.5.1 operating environment,

and ntpd(1M) for Solaris 2.6 and Solaris 7 operating environments) provides a

mechanism for keeping the time settings synchronized between the SSP and the

domains. OBP obtains the time from the SSP when the domain is booted, and NTP

keeps the time synchronized from that point on.

The configuration is based on information provided by the system administrator. If

you are not currently running in an NTP subnet, and you do not have access to the

Internet, and you are not going to use a radio clock, you can set up the Enterprise

TCP/IP Network

SU 10000
platform

CBE
Control
board 0

Control
board 1CBE

CBSClient
(Hostview)

SSP
Chapter 4 SSP Internals 87



10000 system to use its own internal time-of-day clock as the reference clock.

Usually, however, the SSP uses its internal time-of-day clock for the Sun Enterprise

10000 system.

The NTP packages are compiled with support for a local reference clock. This means

that your system can poll itself for the time instead of polling another system or

network clock. The poll is done through the network loopback interface. The first

three numbers in the IP address are 127.127.1. The last numbers in the IP address are

the NTP stratum to use for the clock.

When setting up an Sun Enterprise 10000 system and its SSP, the SSP should usually

be set to stratum 4. The Sun Enterprise 10000 system should be set up as a peer to

the SSP and its local clock should be set two stratums higher.

An example of server/peer lines in the /etc/opt/SUNWxntp/ntp.conf file on the

SSP is shown below.

Under the Solaris 2.5.1 operating environment, you can add the following example

lines to the /etc/opt/SUNWxntp/ntp.conf file on the platform:

Under the Solaris 2.6 and Solaris 7 operating environments, you can add the

following example lines to the /etc/inet/ntp.conf file on the platform:

For more information on the NTP daemon, refer to the Network Time Protocol User’s
Guide and the NTP Reference.

OBP Daemon

On the SSP, OBP is not a hardware PROM; it is loaded from a file on the SSP. An SSP

file also replaces the traditional OBP NVRAM and idprom (hostid).

The obp file is located under a directory path that is specific to the SunOS release.

(Note that SunOS 5.5.1 corresponds to the Solaris 2.5.1 operating environment,

SunOS 5.6 corresponds to the Solaris 2.6 operating environment, and SunOS 5.7

server 127.127.1.4

server ssp_name
server 127.127.1.13

server ssp_name
server 127.127.1.13 stratum 13
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corresponds to the Solaris 7 operating environment. You can determine your SunOS

version with uname -r .) For example, under SunOS 5.5.1, the OBP file is located in

the following directory:

/opt/SUNWssp/release/Ultra-Enterprise-10000/5/5/1/hostobjs/obp

where the /5/5/1 portion of the path corresponds to the SunOS version number. If

your release contains a different version of the operating system, that portion of the

path will be different.

bringup (1M) starts obp_helper (1M) in the background, which kills the previous

obp_helper (1M), if one exists. obp_helper (1M) runs download_helper and

subsequently downloads and runs OBP.

obp_helper (1M) is essential in starting processors other than the boot processor. It

communicates with OBP through bootbus SRAM(BBSRAM), responding to requests

to supply the time-of-day, get or put the contents of the pseudo-EEPROM, and

release slave processors when in multiprocessor mode. To release the slave

processors, obp_helper (1M) must load download_helper into the BBSRAM of all

the slave processors, place an indication in BBSRAM that it is a slave processor, then

start the processor by releasing the bootbus controller reset.

For more information, see the obp_helper (1M), and bringup (1M) man pages and

“download_helper File” on page 90.

Environment Variables

Most of the necessary environment variables are set when the ssp user logs in.

TABLE 4-2 describes the environment variables.

TABLE 4-2 Environment Variables

SUNW_HOSTNAME The name of the domain controlled by the SSP.

SSPETC The path to the directory containing miscellaneous SSP-related

files.

SSPLOGGER The location of the configuration file for message logging. You

should never change the value of this environment variable.

SSPOPT The path to the SSP package binaries, libraries, and object files.

SSPVAR The path to the directory where modifiable files reside.
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Executable Files Within a Domain

These files reside in /opt/SUNWssp/release/Ultra-Enterprise-10000/
os_version and are run within a domain. The man pages for these programs reside

within the domain.

Some of the commands listed in this section must be used or modified only by your

service provider; they are normally called internally by other programs rather than

run on the command line.

Caution – Improper use of these commands can result in failure or damage to the

system. If you are not sure of the function of any command, contact your service

provider for assistance.

*.elf File

These are executable files that are downloaded by hpost (1M).

download_helper File

download_helper enables programs to be downloaded to the memory used by a

domain instead of BBSRAM. This provides an environment in which host programs

can run without having to know how to relocate themselves to memory. These

programs can be larger than BBSRAM.

download_helper works by running a protocol through a mailbox in BBSRAM.

The protocol has commands for allocating and mapping physical to virtual memory,

and for moving data between a buffer in BBSRAM and virtual memory, and

viceversa. When complete, the thread of execution is passed to the new program at

an entry point provided by the SSP. After this occurs, download_helper lives on in

BBSRAM so it can provide reset handling services. Normally, a user would not be

concerned with the download helper; it is used only by the obp_helper (1M)

daemon. See the obp_helper (1M) man page for more information.
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obp File

The obp file is fundamental to the boot process of a domain. OBP knows how to

probe the SBus to determine which devices are connected where, and provides this

information to the operating system in the form of a device tree. The device tree is

ultimately visible using the command prtconf (for more information, see the

SunOS prtconf (1M) man page).

obp also interprets and runs FCode on SBus cards, which provides loadable, simple

drivers for accomplishing boot. In addition, it provides a kernel debugger, which is

always loaded.
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Glossary

Alternate Pathing
(AP) AP enables you to set up an alternate path to system components in case of

failure, repair, or replacement.

AP See Alternate Pathing (AP).

application specific
integrated circuit

(ASIC) In the Sun Enterprise 10000 system, any of the large main chips in the design,

including the UltraSPARC processor and data buffer chips.

arbitration stop A condition that occurs when one of the Sun Enterprise 10000 system ASICs

detects a parity error or equivalent fatal system error. Bus arbitration is frozen,

so all bus activity stops. The system is down until the SSP detects the condition

by polling the Control and Status Registers (CSRs) of the Address Arbiter

ASICs through JTAG, and clears the error condition.

ASIC See application-specific integrated circuit (ASIC).

BBSRAM See bootbus SRAM (BBSRAM).

blacklist A text file that hpost (1M) reads when it starts up. The blacklist file specifies

the Sun Enterprise 10000 system components that are not to be used or

configured into the system. The default path name for this file can be

overridden in the .postrc file (see postrc (4)) and on the command line.

board descriptor
array The description of the single configuration that hpost (1M) chooses. It is part

of the structure handed off to OBP.

bootbus A slow-speed, byte-wide bus controlled by the processor port controller ASICs,

used for running diagnostics and boot code. UltraSPARC starts running code

from bootbus when it exits reset. In the Sun Enterprise 10000 system, the only

component on the bootbus is the BBSRAM.
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bootbus SRAM
(BBSRAM) A 256-Kbyte static RAM attached to each processor PC ASIC. Through the PC,

it can be accessed for reading and writing from JTAG or the processor. Bootbus

SRAM is downloaded at various times with hpost (1M) and OBP startup code,

and provides shared data between the downloaded code and the SSP.

control and status
register (CSR) A general term for any embedded register in any of the ASICS in the

Enterprise 10000 system.

CSR See control and status register (CSR).

DIMM See dual in-line memory module (DIMM).

domain A set of one or more system boards that acts as a separate system capable of

booting the OS and running independently of any other domains.

DRAM See dynamic RAM (DRAM).

dual in-line memory
module (DIMM) A small printed circuit card containing memory chips and some support logic.

dynamic RAM
(DRAM) Hardware memory chips that require periodic rewriting to retain their

contents. This process is called refresh. In Sun Enterprise 10000 system, DRAM

is used only on main memory SIMMs and on the control boards.

Ecache See external cache (Ecache).

external cache
(Ecache) A 0.5-Mbyte to 4-Mbyte synchronous static RAM second-level cache local to

each processor module. Used for both code and data. This is a direct-mapped

cache.

JTAG A serial scan interface specified by IEEE standard 1149.1. The name comes from

Joint Test Action Group, which initially designed it. See JTAG+.

JTAG+ An extension of JTAG, developed by Sun Microsystems Inc., which adds a

control line to signal that board and ring addresses are being shifted on the

serial data line. Often referred to simply as JTAG.

OBP See Open Boot PROM (OBP).

OpenBoot PROM
(OBP) A layer of software that takes control of the configured Sun Enterprise 10000

system from hpost (1M), builds some data structures in memory, and boots the

operating system.

power-on self-test
(POST) A test performed by hpost (1M). This is the program that takes uninitialized

Sun Enterprise 10000 system hardware and probes and tests its components,

configures what seems worthwhile into a coherent initialized system, and

hands it off to OBP.
A-94 Sun Enterprise 10000 SSP 3.1.1 User Guide • August 1999



.postrc A text file that controls options in hpost (1M). Some of the functions can also

be controlled from the command line. Arguments on the command line take

precedence over lines in the .postrc file, which takes precedence over built-in

defaults. hpost -? postrc gives a terse reminder of the .postrc options

and syntax. See postrc (4).

SBus A Sun Microsystems Inc. designed I/O bus, now an open standard.

SRAM See static RAM (SRAM).

static RAM (SRAM) Memory chips that retain their contents as long as power is maintained.

SSP See System Service Processor (SSP).

System Service
Processor (SSP) A workstation containing software for controlling power sequencing,

diagnostics, and booting of a Sun Enterprise 10000 system.

UltraSPARC The UltraSPARC processor is the processor module used in the Sun Enterprise

10000 system.
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blacklisting components, 67
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board with no outline, Hostview, 24
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manual, 64
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bringup domain from command line, 65
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temperature, 29
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CBE (control board executive), 74

CBE (control board executive), overview, 15

CBS (control board server), 74, 86

CBS and CBE, communications port, 75

clear blacklist file, 71

colors in Hostview, 31

command line, creating domains, 58

command line, power(1M), 47

command line, removing domains, 62

commands

bringup, 89

download_helper, 90

obp, 91
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configuration menu, 26

board, 26
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configuration requirements, domain, 56

configure netcontool(1M), 37

configuring control boards, 76
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control and status register (CSR), 94

control board configuration, 76

control board executive (CBE), 74

control board executive (CBE), overview, 15

control board server (CBS), 74, 86

control boards, overview, 15

control menu, 26
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fan, 26

power, 26

controlling fans, Hostview, 54

creating domains, command line, 58

creating domains, Hostview, 56
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edd, 84

obp_helper, 84

SSP, 83

xntpd, 84

dedicated spare SSP, 71

DIMM (definition), 94

display netcon(1M) window, 34

display netcontool(1M) window, 35

domain_create, 58

domain_create(1M) example, 58

domain_remove, 62

domain_remove(1M) example, 62

domain_rename(1M) example, 64

domains, 13

configuration requirements, 56

creating domains, Hostview, 56

domain name must be preconfigured into

system, 58

renaming domains, Hostview, 62

status of domains, Hostview, 65

download_helper command, 90

DRAM (definition), 94

dual control boards, overview, 15

Dynamic System Domains, 13

E
edd daemon, 84

edit menu, 26

elf files, 90

environment variables, 89

SSPETC, 89

SSPLOGGER, 89

SSPOPT, 89

SSPVAR, 89

SUNW_HOSTNAME, 89

error indicators, Hostview, 28

error message files, 43

event detector daemon (edd), 84

exclusive session (netcon), 39

exclusive session permission, netcon(1M), 32

external cache (definition), 94

F
Failure button, Hostview, 30

Fan button, Hostview, 29

fan speed, 55

Fan Status Display window, 53

fan tray display, 54

fans, controlling in Hostview, 54

fans, monitoring in Hostview, 52

features of SSP, 13

file menu, 26

files

error messages, 43

G
green bar, voltage level, 50

H
help menu, 27

help window, Hostview, 28

Hostview, 21

blacklisting components, 68

blacklisting processors, 69

boards in same domain, 24

bringup, manual, 64

clear blacklist file, 71

colors, meaning of, 31

controlling fans, 54

displaying netcontool(1M) window, 36

domains, creating, 56

domains, renaming, 62

domains, status, 65

Failure button, 30

Fan button, 29

Fan Status Display window, 53

help window, 28

icons, meaning of, 30

main window, 23

menu

configuration, 26

board, 26

domain, 26

console, 27

control, 26

bringup, 26
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fan, 26

power, 26

edit, 26

file, 26

help, 27

terminal

netcontool, 27

rlogin, 27

SSP, 27

view

all domains, 27

individual domains, 27

menu bar, 26

monitoring fans, 52

monitoring power, 48

monitoring temperature, 50
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rlogin, 27
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view

all domains, 27

individual domains, 27

menu bar

Hostview, 26

messages file for domain, viewing, 44

messages files, 43

monitor power levels in Hostview, 48

monitoring fans, Hostview, 52

monitoring power, Hostview, 48

monitoring temperature, Hostview, 50

N
netcon(1M), 18, 32

netcon(1M), communication paths for console I/

O, 39

netcon(1M), displaying window, 34

netcon(1M), overview, 18

netcontool(1M) buttons, overview, 33

netcontool(1M), configuration window, 37

netcontool(1M), displaying from Hostview, 36

netcontool(1M), displaying window, 35

Network Console Window, 18

non-dedicated spare SSP, 71

O
OBP (definition), 94
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obp command, 91

OBP. See OpenBootProm

obp_helper daemon, 84

Open Boot PROM (definition), 94

OpenBootProm, 80, 88

out-of-boundary indicators, Hostview, 28
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platform (definition), 13

POST, 82
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postrc(4), 95

power

monitor power levels in Hostview, 48

monitoring power, Hostview, 48

Power button, Hostview, 29

power command, 47

Power Detail window, 49

power off fails when domain running, 46

Power Status Display window, 48

shutdown(1M) and power(1M), 46

power-on self-test (POST), definition, 94

primary control board, 74
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read only session (netcon), 38
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removing domains, command line, 62

renaming domains, Hostview, 62

S
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shutdown(1M) and power(1M), 46

snmp agent, 85

Solaris

version supported, 13

spare SSP, 71
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speed of fans, controlling, 55

SRAM (definition), 95

SSP

user environment, 15

SSP Console Window, 18

SSP daemons, 83

SSP features, 13

ssp log, 26

SSP log file, 43

SSP Logs window, 44

SSP Window, 16

SSP window, 16

SSP, requirements, 13

SSP, spare, 71

SSPETC, 89

SSPLOGGER, 89

SSPOPT, 89

SSPVAR, 89

startup flow, 79

status of domains, Hostview, 65

SUNW_HOSTNAME, 89

swap space required by Hostview, 31

swapping control boards, 76

symbols in Hostview, 30

system board with black outline, Hostview, 25

system board with colored outline, Hostview, 24

system board with no outline, Hostview, 24

system board, selected (in Hostview), 25

system boards in same domain, Hostview, 24

System Service Processor, 13

System Service Processor (SSP), requirements, 13

T
temperature

monitoring temperature, Hostview, 50

temperature button, 29

Temperature button, Hostview, 29

terminal menu

netcontool, 27

rlogin, 27

SSP, 27

Thermal Detail window, 51

U
unlocked write (netcon), 38

unlocked write permission, netcon(1M), 32

user environment, 15
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W
windows

Fan Status Display window, 53

Hostview main window, 23

netcon(1M), 18

netcon(1M), displaying window, 34

netcontool(1M), configuration window, 37

netcontool(1M), displaying window, 35

Network Console Window, 18

Power Detail window, 49

Power Status Display, 48

SSP Console Window, 18

SSP Logs window, 44

SSP Window, 16

Thermal Detail window, 51

X
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Sun Enterprise 10000 SSP Attributions:

This software is copyrighted by the Regents of the University of California, Sun Microsystems, Inc., and

other parties. The following terms apply to all files associated with the software unless explicitly

disclaimed in individual files.

The authors hereby grant permission to use, copy, modify, distribute, and license this software and its

documentation for any purpose, provided that existing copyright notices are retained in all copies and that

this notice is included verbatim in any distributions. No written agreement, license, or royalty fee is

required for any of the authorized uses. Modifications to this software may be copyrighted by their authors

and need not follow the licensing terms described here, provided that the new terms are clearly indicated

on the first page of each file where they apply.

IN NO EVENT SHALL THE AUTHORS OR DISTRIBUTORS BE LIABLE TO ANY PARTY FOR DIRECT,

INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF

THIS SOFTWARE, ITS DOCUMENTATION, OR ANY DERIVATIVES THEREOF, EVEN IF THE AUTHORS

HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

THE AUTHORS AND DISTRIBUTORS SPECIFICALLY DISCLAIM ANY WARRANTIES, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A

PARTICULAR PURPOSE, AND NON-INFRINGEMENT. THIS SOFTWARE IS PROVIDED ON AN “AS IS”

BASIS, AND THE AUTHORS AND DISTRIBUTORS HAVE NO OBLIGATION TO PROVIDE

MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICATIONS.

RESTRICTED RIGHTS: Use, duplication or disclosure by the government is subject to the restrictions as set

forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software Clause as DFARS

252.227-7013 and FAR 52.227-19.

This is scotty, a simple tcl interpreter with some special commands to get information about TCP/IP

networks. Copyright (c) 1993, 1994, 1995, J. Schoenwaelder, TU Braunschweig, Germany, Institute for

Operating Systems and Computer Networks. Permission to use, copy, modify, and distribute this software

and its documentation for any purpose and without fee is hereby granted, provided that this copyright

notice appears in all copies. The University of Braunschweig makes no representations about the suitability

of this software for any purpose. It is provided as is” without express or implied warranty.
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